Whats new in Micosoft Access 2003

Security enhancements

Access 2003 allows you to protect against potentially unsafe Visual Basic for Applications (VBA) code by setting the macro security level. You can set the security level so that you are prompted every time that you open a database containing VBA code, or you can automatically block databases that are from unknown sources. This is the default and the biggest visible change to the user.
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Access also utilizes the Microsoft Jet Expression Service enhanced sandbox mode to block potentially unsafe functions from being used in expressions. This means that any form with calculations, and any query using functions will fail unless you disable sandbox mode.

Access uses Microsoft Authenticode technology to enable you to digitally sign a macro project by using a digital certificate. The certificate used to create this signature confirms that the macro originated from the signer, and the signature confirms that it has not been altered. When you set the macro security level, you can run macros based on whether they are digitally signed by a developer on your list of trusted sources.

· Digital signature: confirms that the macro or document originated from the signer and has not been altered.
· Macro project: A collection of components, including forms, code, and class modules, that make up a macro.
· Digital certificate: Attachment for a file, macro project, or e-mail message that vouches for authenticity, provides secure encryption, or supplies a verifiable signature. To digitally sign macro projects, you must install a digital certification.
To disable sandbox mode (to remove the messages altogether):

1. On the Tools menu, point to Macro, and then click Security. 

2. Click the Security Level tab, and then click Low (clicking Medium will make all your forms and queries work again, but you are still confronted by the initial questions upon opening any database)
3. Click OK. 

4. Restart Access.

Autocorrect
Name Autocorrect is the ability to rename objects in queries, forms and reports when the object has been renamed in the Table design. The name map of an object is updated each time you save and close it. Name AutoCorrect cannot repair all references to renamed objects. This facility has been around for some time, but it has been enhanced in Access 2003 and is a partial solution to not having a data dictionary.
· In Microsoft Access 97 and previous versions, if you rename a field in a table, the objects based on that field no longer display the data from that field. Tracking name changes is not automatically turned on.
· In Access 2000 or later, you can make Access track name changes, or automatically correct common side effects that occur when you rename forms, reports, tables, queries, fields, text boxes or other controls (not boilerplate). Tracking is turned on by default. When tracking name changes is enabled for a database, you might notice an increase in the database size. 

Macros, modules, and data access pages are not searched for dependencies, nor are objects not supported by the autocorrect feature such as action queries and SQL-specific queries, including union queries, data-definition queries, pass-through queries, and subqueries. Nested queries are partially supported and lookup fields are not listed as objects that the query depends on. Linked table references are not corrected either. These have to be updated manually.
· In Access 2003, it is now possible to view dependency information for tables, queries, forms, and reports, and flag errors caused by changes.
The name AutoCorrect settings are available on the General tab of the Options dialog box. 
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You can enable name AutoCorrect in three levels: 

· Track name changes. Access simply keeps track of the name changes in the database. It does not fix the errors caused by renaming. When you enable tracking for the first time, Access creates name maps for each existing database object, keeps it up-to-date. The maps are used to fix errors caused by renaming, as well as to generate object dependency information.

· Track changes and automatically fix errors caused by renaming. Access automatically fixes name changes as and when they are made. This is the default.
· Track changes, fix errors, and maintain a log of changes made by name AutoCorrect. Access will maintain a log of changes made to object names. Each change will appear as a record in the Name AutoCorrect Log table. 

AutoCorrect and object dependency information

Access 2003 makes it possible to view dependency information (generated from Autocorrect name maps) for tables, queries, forms, and reports. You can view the list of objects that depend on a selected table or form. You can also view the objects that the table or form depends on. This helps maintain a database over time and avoid errors related to missing record sources. For example, a query in the database is no longer needed, but before deleting it, you might want to find out which other objects in the database use the query. You could then either change the record source of the dependent objects, or delete them, before deleting the query. 
· tracking name AutoCorrect information needs to be turned on. 
· performing name Autocorrect need not be enabled. 
· If any object is open, it must be saved and closed so that Access can generate accurate information. 

· Click on the expand (+) icon next to an object to see dependency information for that object, or right click on an object and select “object dependencies
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Error checking in forms and reports

In Access 2003, you can enable automatic error checking for common errors in forms and reports. Error checking points out errors, such as two controls using the same keyboard shortcut, and the width of a report being greater than the page it will be printed on. Enabling error checking helps you identify errors and correct them. 

Select Error Checking from the Tools/ Options menu to see what you can check.
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You will see an error indicator on the top left corner of the control. If you select the control with an error indicator, the Error Checking Options button appears. If you rest your mouse pointer on the Error Checking Options button and then click the arrow in the button, a menu displays a set of options to correct or ignore the error. 

Autocorrect and Propagating field properties

In previous versions of Microsoft Access, whenever you modified a field's inherited property, you had to manually modify the property of the corresponding control in each of the forms and reports. 
· You need to make sure that Perform name autocorrect is switched on. 

· When you modify a field property in Table design view, Access displays an option to update the property of all or some controls that are bound to the field. 
· Try changing lastname in the students table to surname, you get an error indicator on the control if you only have tracking name turned on
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Autocorrect options

In Access 2003, you have more control over the behaviour of the AutoCorrect feature. On the Tools menu, click AutoCorrect Options. There is an extra show autocorrect options buttons option. The AutoCorrect Options button appears near text that was automatically corrected. If you find that you do not want text to be corrected, you can undo a correction or turn AutoCorrect options on or off by clicking the button. 

Back up a database or project

You can back up the current database or project before making major changes to it. The backup will be saved in the default backup location, or in the current folder as an mdb file. This is a slightly more flexible facility than using Explorer to copy files since it automatically identifies the file with the date. 
Note You can back up individual database objects by creating a blank database and then importing the objects you want from the original database. You can also use File/ Export to save tables and queries in different formats.
1. Save and close all objects in the database. 

2. On the File menu, click Back Up Database. 

3. In the Save Backup As dialog box, specify the name and location of the backup copy. Caution If you are using user-level security you should also create a backup of the workgroup information file. If this file is lost or damaged, you won't be able to start Microsoft Access until you restore or rebuild it.

Improved sorting in controls

You can now specify the ascending or descending sort order of up to four fields when using the List Box and Combo Box Wizards in forms and reports, and the Lookup Wizard in a table. This avoids having to add the sort order later using the query builder.
Enhanced font capabilities in SQL views

In the SQL and query Design views of a query in an Access database, you can now change the font and font size of the text by using the Query design font option added to the Tables/Queries tab of the Options dialog box under the Tools menu. Previously only the datasheet font could be changed. These settings apply to all databases and work with the high-contrast and other accessibility settings of your computer. 
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Context-based Help in SQL view

 In the SQL view of a query in a Microsoft Access database, you can now get help specific to Jet SQL keywords, VBA functions, and Access functions. Simply press F1 to bring up the help that corresponds to the text near the cursor. You can also search the Jet SQL and VBA function reference topics. This only applies in the SQL view.
Importing, exporting, and linking

Importing, exporting, and linking to a Microsoft Windows SharePoint Services list from Access

We do not support this service. You can perform the following operations with a Windows SharePoint Services list:

· Export the contents of a table or a query to a list. 

· Import the contents of a list into a table. 

· Link a table to a list.

Make a local table from a linked table

In Access 2003, you can make a local copy of the structure or data and structure contained in a linked table rather than having to export it.
XML support

With the enhanced XML support in Access 2003, you can specify a transform file when you import data from or export data to XML. The transform is then applied automatically. When you import XML data, the transform is applied to the data as soon as the data is imported, before any new table is created or an existing one is appended to. When you export data to XML, the transform is applied following the export operation. 

Often times a database contains lookup values that are stored in another database. You can now include these related tables when exporting. You can also include any predefined filter or sort order for an object when exporting the object.

More new features

Smart tags

In Access 2003, you can use the SmartTags property to add a smart tag to perform actions to any field in a table or query, any control in a form, report, or data access page in a database to  save time. Microsoft (and other third party suppliers) provide a set of ready-to-use smart tags with Access 2003: Unfortunately they relate to other Microsoft products that we do not support so they are not particularly useful
· You use the Person Name smart tag when you need to add to or change the contact information that you store in Microsoft Outlook. You can take these actions with the Person Name smart tag:

· Send an e-mail message to a contact. 

· Schedule a meeting with a contact. 

· Open and edit a contact's information. 

· Add the name in control to your list of contacts.

· You use the Financial Symbol smart tag to look up information about a financial symbol on MSN® MoneyCentral® You can take these actions with the Financial Symbol smart tag:

· Obtain a stock quote on MSN MoneyCentral. 

· Obtain a report about the company on MSN MoneyCentral. 

· Obtain recent news about the company on MSN MoneyCentral.

· You use the Date smart tag to schedule a meeting or show your Outlook calendar based on the date in the active control. You can take these actions with the Date smart tag:

· Schedule a meeting. 

· Display your calendar. 

In the SmartTags property box, do one of the following: 

· Click the Build button [image: image9.png]


in the SmartTags property box to open the Smart Tags dialog box. Click the smart tag that you want to add to the control, and then click OK. 

· Type the namespace Uniform Resource Identifier (URI) for the smart tag in the SmartTags property field. 

Windows XP theme support

The Microsoft Windows XP (SP1 or later) operating system offers you several themes. 

1. In Windows XP Control Panel, click Appearance and Themes, and then click Change the computer's theme. 

2. In the Display Properties dialog box, click the Appearance tab. 

3. Do one of the following: 

· To use the new look in your Office programs, use the Windows XP style. In the Windows and Buttons list, click Windows XP style. To change the colors, click the item you want in the Color scheme list, such as Silver. 

· To have your Office 2003 programs look similar to Office XP, use the Windows Classic style. In the Windows and Buttons list, click Windows Classic style. To change the colors, click the item you want in the Color scheme list, such as Windows Standard
In Windows 2000  Control Panel, double-click the Display icon, Click the Appearance tab. In the Scheme list, click the scheme you want, such as Windows Standard
If you have chosen a theme other than the default, Access will apply the chosen theme to views, dialog boxes, and controls. To apply the current Windows theme to form controls
· On the Tools menu, click Options. On the Forms/Reports tab, select the Use Windows Themed Controls on Forms check box.

You can prevent form controls from inheriting themes from the operating system by clearing the Use Windows Themed Controls on Forms check box.
New look for Office
Microsoft Office 2003 has a new look. Additionally, new and improved task panes are available to you including Getting Started, Help, Search Results, and Research. 

Tablet PC support
On a Tablet PC, you can quickly provide input using your own handwriting directly into Office documents as you would using a pen and a printout. Additionally, you can now view task panes horizontally to help you do your work on the Tablet PC the way you want to do your work.

Microsoft Office Online
Microsoft Office Online is better integrated in all Microsoft Office programs so that you can take full advantage of what the site has to offer while you work. You can visit Microsoft Office Online directly from within your Web browser or use the links provided in various task panes and menus in your Office program to access articles, tips, clip art, templates, online training, downloads, and services to enhance how you work with Office programs. The site is updated regularly with new content based on direct feedback and specific requests from you and others who use Office.
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